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1 Foreword

1.1 Notes on the documentation
This description is only intended for the use of trained specialists in control and automation engineering who
are familiar with applicable national standards.
It is essential that the documentation and the following notes and explanations are followed when installing
and commissioning the components. 
It is the duty of the technical personnel to use the documentation published at the respective time of each
installation and commissioning.

The responsible staff must ensure that the application or use of the products described satisfy all the
requirements for safety, including all the relevant laws, regulations, guidelines and standards.

Disclaimer

The documentation has been prepared with care. The products described are, however, constantly under
development.
We reserve the right to revise and change the documentation at any time and without prior announcement.
No claims for the modification of products that have already been supplied may be made on the basis of the
data, diagrams and descriptions in this documentation.

Trademarks

Beckhoff®, TwinCAT®, TwinCAT/BSD®, TC/BSD®, EtherCAT®, EtherCAT G®, EtherCAT G10®, EtherCAT P®,
Safety over EtherCAT®, TwinSAFE®, XFC®, XTS® and XPlanar® are registered trademarks of and licensed by
Beckhoff Automation GmbH.
Other designations used in this publication may be trademarks whose use by third parties for their own
purposes could violate the rights of the owners.

Patent Pending

The EtherCAT Technology is covered, including but not limited to the following patent applications and
patents:
EP1590927, EP1789857, EP1456722, EP2137893, DE102015105702
with corresponding applications or registrations in various other countries.

EtherCAT® is a registered trademark and patented technology, licensed by Beckhoff Automation GmbH,
Germany

Copyright

© Beckhoff Automation GmbH & Co. KG, Germany.
The reproduction, distribution and utilization of this document as well as the communication of its contents to
others without express authorization are prohibited.
Offenders will be held liable for the payment of damages. All rights reserved in the event of the grant of a
patent, utility model or design.
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1.2 For your safety
Safety regulations

Read the following explanations for your safety.
Always observe and follow product-specific safety instructions, which you may find at the appropriate places
in this document.

Exclusion of liability

All the components are supplied in particular hardware and software configurations which are appropriate for
the application. Modifications to hardware or software configurations other than those described in the
documentation are not permitted, and nullify the liability of Beckhoff Automation GmbH & Co. KG.

Personnel qualification

This description is only intended for trained specialists in control, automation, and drive technology who are
familiar with the applicable national standards.

Signal words

The signal words used in the documentation are classified below. In order to prevent injury and damage to
persons and property, read and follow the safety and warning notices.

Personal injury warnings

 DANGER
Hazard with high risk of death or serious injury.

 WARNING
Hazard with medium risk of death or serious injury.

 CAUTION
There is a low-risk hazard that could result in medium or minor injury.

Warning of damage to property or environment

NOTICE
The environment, equipment, or data may be damaged.

Information on handling the product

This information includes, for example:
recommendations for action, assistance or further information on the product.
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1.3 Notes on information security
The products of Beckhoff Automation GmbH & Co. KG (Beckhoff), insofar as they can be accessed online,
are equipped with security functions that support the secure operation of plants, systems, machines and
networks. Despite the security functions, the creation, implementation and constant updating of a holistic
security concept for the operation are necessary to protect the respective plant, system, machine and
networks against cyber threats. The products sold by Beckhoff are only part of the overall security concept.
The customer is responsible for preventing unauthorized access by third parties to its equipment, systems,
machines and networks. The latter should be connected to the corporate network or the Internet only if
appropriate protective measures have been set up.

In addition, the recommendations from Beckhoff regarding appropriate protective measures should be
observed. Further information regarding information security and industrial security can be found in our
https://www.beckhoff.com/secguide.

Beckhoff products and solutions undergo continuous further development. This also applies to security
functions. In light of this continuous further development, Beckhoff expressly recommends that the products
are kept up to date at all times and that updates are installed for the products once they have been made
available. Using outdated or unsupported product versions can increase the risk of cyber threats.

To stay informed about information security for Beckhoff products, subscribe to the RSS feed at https://
www.beckhoff.com/secinfo.

https://www.beckhoff.com/secguide
https://www.beckhoff.com/secinfo
https://www.beckhoff.com/secinfo
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2 Overview
The TwinCAT 3 CAD Simulation Interface is a tool for conveniently configuring a coupling between
TwinCAT 3 and a 3D CAD system. This tool supports simulation of any motion in various 3D CAD programs.
Thus, the program allows PLC programmers to perform functionality tests on the PLC code at an early stage
and with little effort. Simple motion axes and complex kinematics can be simulated and tested directly in the
3D CAD system. Light barriers and limit switches can be tested using collision detection. Machine error
situations can also be evaluated after they have occurred.

You can also use the TwinCAT 3 CAD Simulation Interface to train operators and maintenance staff in
advance for regular operation and to define work instructions for troubleshooting based on simulated critical
machine states. In addition, presales training for sales support for machines or machine components can
also be carried out using 3D simulations.

With the TwinCAT 3 CAD Simulation Interface, configuring the 3D simulation is easy. The simulation tool
uses the design data from the CAD tool and links it to the automation data. This also results in the advantage
of parallel design, manufacturing, and programming.

Currently, you can use the TwinCAT 3 CAD Simulation Interface with the following CAD programs:

• Autodesk® Inventor®

• Dassault Systèmes SOLIDWORKS®
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3 Installation

3.1 System requirements
Technical data Description
Operating system Windows 10
Minimum TwinCAT version
available with restrictions

TwinCAT 3.1.4024.20

Minimum TwinCAT version
for optimal use

TwinCAT 3.1.4026.00

TwinCAT licenses TE1130 TwinCAT 3 CAD Simulation Interface,
TE1131 TwinCAT 3 CAD Simulation Interface Maintenance

Requires TC1000 TC3 ADS
Supported CAD systems Autodesk® Inventor® 2019, 2020, 2021, 2022, 2023

Dassault Systèmes SOLIDWORKS® 2017, 2018, 2019, 2020, 2021,
2022, 2023 with:
SOLIDWORKS® Premium or
SOLIDWORKS® Standard incl. Simulation Standard

3.2 Installation
The TwinCAT 3 CAD Simulation Interface is installed:

• for TwinCAT 3.1.4026 as a TwinCAT Package or
• for TwinCAT 3.1.4024 via a separate installer

To install TwinCAT 3 CAD Simulation Interface, run the setup wizard and follow the instructions.

3.3 Licensing
The TwinCAT 3 CAD Simulation Interface is an engineering product. The licensing takes place exclusively
on the engineering system. The guide to licensing a full version can be found in the Beckhoff Information
System in the documentation "TwinCAT 3 Licensing".

TE1131 TwinCAT 3 CAD Simulation Interface Maintenance

For the annual update of the TwinCAT 3 CAD Simulation Interface you need the maintenance license
TE1131 TwinCAT 3 CAD Simulation Interface Maintenance. This maintenance license allows you to use
regular improvements and new features for one year. If you do not re-purchase the maintenance license at
the end of the year, you will no longer receive new content and features. You will then use the program
version that corresponds to the last paid maintenance license. To continue receiving regular updates, you
must purchase the maintenance license annually.

With the maintenance license, we provide you with updates of the TE1130 TwinCAT Add-in for new versions
of the CAD software in addition to regular updates. We thus ensure that you can use the add-in with your
current version of the CAD software.

https://infosys.beckhoff.com/content/1033/tc3_licensing/2346413835.html


Basic principles

TE113010 Version: 1.0.1

4 Basic principles
The TwinCAT 3 CAD Simulation Interface connects TwinCAT with 3D CAD software. The goal of this
coupling is "software-in-the-loop simulation" (SiL simulation, abbreviated as SiL in the following). In virtual
commissioning or in an SiL, a closed loop is essential. I.e. values are written from the controller to the CAD
model (axis positions) and at the same time values are fed back from the model to the controller/PLC
(sensor values). In this context, the visualization or simulation helps the programmer to better understand the
behavior of the controller and to detect possible problems in this loop.

The TwinCAT 3 CAD Simulation Interface uses the design data from the CAD tool and the position values
and other values from the TwinCAT project for the SiL. The axes to be moved, which must be configured in
the CAD system, are imported into this TwinCAT project. The CAD software parameters are linked to the
TwinCAT symbols for the simulation of motion.

The 3D simulation is not real-time capable because most CAD programs run on standard Windows systems
or do not have a real-time simulation environment.

Operating principle

To run a simulation with the TwinCAT 3 CAD Simulation Interface, a 3D model and a PLC project are
required as a basis. When a 3D model is being designed in CAD software, the assemblies and axes that
should be mobile later on must be configured accordingly. In addition, a PLC project is required in TwinCAT
to control the machine's movement. In the TwinCAT 3 CAD Simulation Interface, the 3D model's mobile
simulation axes are connected to the PLC. When running the simulation, the values are copied from the
controller to the model as axis positions and values are simultaneously fed back from the model to the
controller as sensor values. The movement that occurs due to the commands from the controller is displayed
in the 3D model.

For the application of the TwinCAT 3 CAD Simulation Interface, TwinCAT is triggered by an external CAD
program. The TwinCAT 3 Usermode Runtime enables synchronous integration of the execution for this
purpose. The TwinCAT 3 Usermode Runtime offers an interface for this, whereby the ticks for the runtime
are specified externally. The TwinCAT Usermode Runtime is initialized and started in the respective CAD
tool via the CAD-specific add-in. After initializing the Usermode Runtime, the target can be selected in
TwinCAT. After starting the runtime, values can be exchanged between CAD tool and TwinCAT. The
Usermode Runtime used for coupling the TwinCAT project and the CAD tool is tasked with ensuring
synchronous execution of the non-real-time capable CAD tool and the real-time capable PLC code.
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5 Preparing the CAD
The following chapter explains how the TwinCAT 3 CAD Simulation Interface operates for the Autodesk®

Inventor® and Dassault Systèmes SOLIDWORKS® CAD programs.

This mainly concerns the preparation of the simulation and its subsequent configuration in TwinCAT. Since
the operation here differs between the CAD programs, the instructions are split into Inventor® and
SOLIDWORKS® respectively. Afterwards operation in TwinCAT is explained.

5.1 Inventor®
This subchapter explains the functional principle and operation in Inventor®.

Slow simulation
Several factors within Inventor® slow down the simulation. Multiple opened Inventor® instances and
the set visual style are among these factors.
• Only open one Inventor® instance at a time for the simulation.
• Reduce the axis and collision sensor to a minimum.
• Use simple parts for collision detection.
• Go to View>Display>Visual Style and set a simple visual style , for example "Technical

Illustration" or "Shaded".
• Under View>Display, disable Ray Tracing.

Inventor® function Contact Solver does not work in conjunction with TE1130 Inventor Add-in.
• Disable the function under Inspect>Disable Contact Solver.

Principle of operation

You have two options for creating a CAD model in Inventor® that allows you to use the TwinCAT 3 CAD
Simulation Interface.

1. Joints:
Parts can be moved via joints in the CAD model. These joints have a parameter that can be
defined in TwinCAT. If the value changes, the position of the part to be moved also changes.

2. Constraints:
A constraint specifies the distance or angle between parts. There is one parameter for each
constraint in Inventor®. This parameter value can be changed in TwinCAT. If the value changes,
the position of the part to be moved also changes.

Displacement sensors

In contrast to the axes, which write parameter values, the displacement sensors read parameter values. For
example, in kinematics such as delta kinematics, the position parameter of the joint, which is located in the
Tool Center Point (TCP), can be read. This is used to check whether the position moved to is the desired
target position.

Collision sensors

Sensors can be defined for collision detection with the TwinCAT 3 CAD Simulation Interface in Inventor®,
which are used to check the collision between two selected parts and pass it to TwinCAT as BOOL
variables.

5.1.1 TE1130 Inventor® Add-in
To use the TwinCAT 3 CAD Simulation Interface, an add-in is started in Inventor®. This is used to start the
TwinCAT Usermode Runtime, filter parameters, configure motion axes and create the sensors, for example.
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For technical reasons, the Inventor® Add-in functions only in the first opened Inventor® instance.

TE1130 Inventor® Activate add-in

The first time you want to use the add-in in Inventor®, it may not be displayed in the ribbon. In this case, you
need to activate the add-in.

Proceed as follows:

1. Click the Tools tab on the ribbon in the Inventor® startup window.
2. Click the Add-Ins button.
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ð The Add-In Manager window opens.

3. Select the add-in TE1130 Inventor® Runtime.
4. Check Loaded/Unloaded.
5. Check Load Automatically.
6. Click the OK button.
ð The add-in is now displayed in the ribbon at Add-Ins.

Operating buttons of the TE1130 Inventor® add-in

You can find the add-in on the Add-Ins tab in Inventor®. The controls of the add-in are described below.
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Configuration Open configuration window to set axes and sensors.
Export TMC File Export TwinCAT Module Class file. 

After changes in the configuration in the CAD model you can update the TMC file
with which the configuration is imported into TwinCAT. 
(Valid for the beta version and only required for use with TwinCAT 4024)

Initialize The function initializes the Usermode Runtime so that the "Inventor Machine" can
be selected as a target in TwinCAT.

Start Start TwinCAT Runtime from Inventor®.
Continue Continue TwinCAT Runtime.
Terminate Exit TwinCAT Runtime completely.
Stop Set TwinCAT Runtime to configuration mode from Inventor®.
Pause Stop TwinCAT Runtime to operate Inventor®.
Runtime Informations Displays information about the runtime. 

(product version numbers, initialized model, etc.)
Help Links to the help pages on the Internet.

5.1.2 Creating motion axes in Inventor® with "Joint" -
Recommended procedure

In the first step of simulation preparation, you set up or adjust the parameters of the motion axes in the CAD
model. The recommended procedure for creating parameters in Inventor®is stated in the following. In this
procedure, the constraint of the movable part is defined with the "Joint" function. In the following example,
place the origin of a joint at the top of the linear guide on the miller and select a surface along the linear
guide as the joint plane.

For the simulation, it does not matter which units are set in the assemblies. The motion axis and
displacement sensor units are set in TwinCAT.

ü You do not need to set any constraints between the two assemblies or parts.
ü Parts can be rotated or moved in the desired direction of movement.
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ü Parts or assemblies which move relative to each other are placed next to each other.

1. Click Assemble>Relationships>Joint.
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ð The following window opens:

2. Select the desired joint type under Type. 
This can be "Slider", "Rotational" or "Automatic", for example. With the "Automatic" joint type, Inventor®

automatically selects the joint type depending on the parts to be connected.
3. To select the origin of the joint on the first assembly or part, click the 1 button under Connect.
4. Now select the corresponding point in the CAD model. Pay attention to the joint plane here.

ð In the picture, you can see that the origin is placed at the top of the linear guide on the miller.
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ð The following negative example shows how the same point was selected, but it is on the wrong joint
plane.

ð Inventor® now automatically activates button 2 and you can define the second point of the joint.
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5. Set the second point of the joint on the second assembly or part by selecting it in the CAD model.

ð After successful joint definition (no conflicts) Inventor® animates the joint. If you click on the joint in
the model tree, then the joint origin as well as the (positive) direction of movement is displayed in
Inventor®.

If required, you can adjust the direction of movement later in TwinCAT via the TcCom options with
"InvertDirection". It may also be easier to adjust the joint origin via the Offset TcCom option in
TwinCAT than in Inventor®. This is the procedure we recommend.
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6. Click Parameters under Assemble>Manage.
ð The following window opens:

ð The bottom two rows belong to the defined slider joint. The parameter "d126" describes the distance
between the two selected joint planes. Parameter "d127" describes the travel distance. For
TwinCAT 3 CAD Simulation Interface only "d127" is relevant. We recommend that parameters be
given a unique name.

7. To rename the parameter, click in the left column of the table.
8. Enter the desired name. Note that there is the option to assign prefixes which can then be used for

filtering later.
9. Confirm with Done.

ð The slider joint is now defined in the corresponding assembly and can be moved within this
assembly.

10. Before initializing runtime eventually configure [} 22] CAD Simulation Interface.
11. Initialize the runtime from Inventor® then use the ScanIO function in your TwinCAT project.
12. Link the I/O master inputs to the relevant inputs in the PLC project. Link the individual I/O master outputs

with an output of an NC axis or a suitable output in the PLC project.
See chapter I/O master set up in TwinCAT [} 34].

13. Activate the TwinCAT project.
ð The query asking whether the TwinCAT system should be started in Run Mode appears.

14. Confirm with OK.
ð The simulation is activated, but is in the pause state.

15. To trigger the runtime, click the Continue button in the TE1130 Inventor® add-in.
ð The simulation is active and the TwinCAT project is triggered by the Usermode Runtime.

5.1.3 Create motion axes in Inventor® with "Constrain"
In the procedure described below, the constraint of the movable part is set with the "Constrain" function and
thus the parameter is created.

For the simulation, it does not matter which units are set in the assemblies. The motion axis and
displacement sensor units are set in TwinCAT.

ü The part must be able to be rotated or displaced in the desired direction of movement.
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1. Click the Constrainfunction.

2. Create a parameter by selecting one of the following constraint types: 
Mate for translatory motion – with Mate and Flush modes
Angle for rotational motion – with Directed Angle, Undirected Angle, and Explicit Reference Vector
modes. 

3. In this example, select Flush.
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4. Select the reference edge or plane on the part to be moved (purple).

5. Select the reference edge or plane on the part that the part (blue) will move in relation to.

ð After placing the constraint, the parameter is added to the constrained parts in the model tree as a
constraint.

ð A parameter representing the constraint is appended to the parameter list.
6. Rename the parameter by double-clicking the name so that you can find it more easily for linking.
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ð A parameter representing the constraint is appended to the parameter list.

7. Before initializing runtime eventually configure [} 22] CAD Simulation Interface.
8. Initialize the runtime from Inventor® then use the ScanIO function in your TwinCAT project.
9. Link the I/O master inputs to the relevant inputs in the PLC project. Link the individual I/O master outputs

with an output of an NC axis or a suitable output in the PLC project.
See chapter I/O master set up in TwinCAT [} 34].

10. Activate the TwinCAT project.
ð The query asking whether the TwinCAT system should be started in Run Mode appears.

11. Confirm with OK.
ð The simulation is activated, but is in the pause state.

12. To trigger the runtime, click the Continue button in the TE1130 Inventor® add-in.
ð The simulation is active and the TwinCAT project is triggered by the Usermode Runtime.

5.1.4 TwinCAT CAD Simulation Interface configuration
Click the Configuration button in the TwinCAT Add-in to open the configuration window, in which you
execute settings for the axes and sensors.

Settings in the configuration window

You can execute the following settings in the configuration window:

1. Click the Configuration button in the TwinCAT Add-in.
ð The TwinCAT TE1130 Configurator is opened, in which the configurations can be executed. The

Actuation configurator tab is opened.
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ð The default value 40 ms is entered in the input field Sample time.
2. Activate the checkbox under Dynamic sample time, so that the sample time adjusts automatically.

ð The number of steps in TwinCAT is adapted to the calculation time of the CAD system.
3. Activate the checkbox under Automatically initialize, so that the TwinCAT Runtime for the model is

automatically initialized immediately when it is opened.
4. On the Actuation configurator tab, select parameters as motion axes.
5. Activate the checkbox Actuators to filter axes by their name.

ð All joints that have the prefix "axis_" in their name are automatically filtered and selected.
6. Configuration of collision sensors is performed on the Collision sensor configurator tab.
7. Select parameters as displacement sensors on the Displacement sensor configurator tab.
8. Activate the checkbox Displacement sensors to filter axes by their name.

ð All joints that have the prefix "sensor_" in their name are automatically filtered and selected.
ð The more advanced configurations can be found below.

Set sample time

In the TwinCAT Configurator, the sample time is used to set the ticks per sample for the Usermode Runtime.
This means that with a set sample time of 40 ms and a base time of 1 ms in TwinCAT, 40 ticks are executed
every time new parameter values are written or sensor values are read into the controller. The smaller this
value is, the smoother the axes move in Inventor®, but the slower the controller runs.

Select axes without filter function
ü You are on the Actuation configurator tab.
ü The filter function for actuators is disabled.
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1. To select axes, drag and drop the desired parameters into the right-hand selection area of the
configuration window.

2. Use the arrow keys to change the arrangement of the axes. This has no influence on the order in which
these are created in the I/O master.

ð The selected axes can now be used for the simulation.

Selection of displacement sensors without filter
ü You are on the Displacement sensor configurator tab.
ü The filter function for displacement sensors is disabled.
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1. To select displacement sensors, drag them from the parameter list to the right-hand selection area of the
configuration window.

2. Use the arrow keys to change the order of the selected displacement sensors. This has no influence on
the order in which these are created in the I/O master.

ð You can now use the selected displacement sensors for the simulation.

Setting the filter function

You can use a filter function for configuring axes and sensors, via which the desired parameters are
automatically filtered and selected. To use this function, name the desired parameters appropriately with a
prefix. For parameters, use the prefix "axis_", for example "axis_xxx". Joints used as sensors are given a
name with the prefix "sensor_", for example "sensor_xxx". If you have named the parameters appropriately,
they will be selected automatically.

To name axes and sensors appropriately, proceed as follows:

1. Select the Assemble tab.
2. Select Parameters.
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3. The Parameters window opens.

4. Click in the field with the desired parameter.

5. Enter the desired name with matching prefix.
6. Confirm with the Done button.
ð The parameters have been renamed.

To filter and select axes, proceed as follows:

1. Open the TwinCAT Add-In.
2. Click the Configuration button.

ð The TwinCAT TE1130 Configurator window opens.
3. Check the Actuators or Displacement sensors checkbox.

ð The right-hand selection area of the configuration window is grayed out and only the axes and sensors
with the prefix are selected.

Range monitoring

Range monitoring is activated and deactivated in the configuration window. The lower and upper limits for
range monitoring are set in the TwinCAT project after scanning.
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You have two options to activate or deactivate range monitoring:

Checkbox:

1. Check or uncheck the Range monitoring checkbox.

ð Range monitoring of the selected parameter is now activated or deactivated.

Prefix:

1. Enter the abbreviation "rm" in the prefix of the axis or sensor.
ð Range monitoring is activated for the axes and sensors with the prefixes "axis_rm_" and "sensor_rm_".

Configuration of collision sensors

In order to use the collision detection, you need to add "sensors" to the configuration.

1. Open the Collision sensor configurator tab.
2. Click the Add sensor button.

ð A sensor configuration is added in the right-hand selection area of the configuration window. 

3. Enter a name for the sensor.
ð From here you have two options:
1. Drag and drop the parts that a collision check is to be performed for into the fields Part A and Part B.
2. Click the button Select part A in CAD or Select part B in CAD and then select the part in the CAD

model.
ð This sensor is displayed in the System Manager via the TMC file in the I/O master and can be linked

there. You can find the sensors under the I/O group InventorCollisionsSensors.

Settings in the configuration window finished

In the next step, link the axes and sensors together, see chapter I/O master set up in TwinCAT [} 34]. The
TwinCAT project must be activated after linking. The Usermode Runtime can be started and stopped from
TwinCAT and from Inventor® using the start and stop buttons.
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5.2 SOLIDWORKS®
This subchapter only explains operation in SOLIDWORKS®.

You need the SOLIDWORKS® Motion package to use the TwinCAT 3 CAD Interface Simulation
function. This is already included in SOLIDWORKS® Premium and SOLIDWORKS® Simulation
Standard.

5.2.1 TE1130 SOLIDWORKS® Add-in
An add-in is integrated into SOLIDWORKS® so that the TwinCAT 3 CAD Simulation Interface can be used.
You can start the TwinCAT Usermode Runtime here, for example.

Activation of the TE1130 Add-in

If the TE1130 Add-in is not activated automatically, activate it as follows:

1. Click Options in the toolbar.

2. Check the TE1130_SOLIDWORKS_AddIncheckbox.

3. Check the checkbox under Start Up.
4. Click OK.
ð You can now find the add-in in the SOLIDWORKS® menu bar.
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Operation of the TE1130 Add-in

The controllers of the add-in are described below.

Initialize Initialize TwinCAT Runtime.
Start Start TwinCAT Runtime from SOLIDWORKS®.
Stop Stop TwinCAT Runtime from SOLIDWORKS®.
Terminate Terminate TwinCAT Runtime completely.
Export TMC File Export TwinCAT Module Class file.

(Valid for the beta version and only required for use
with TwinCAT 4024)

Select MotionStudy Select the motion study you want to simulate.

5.2.2 Creation of motion axes in SOLIDWORKS®
To use the TwinCAT 3 CAD Simulation Interface in SOLIDWORKS®, you must activate the SOLIDWORKS®

Motion Add-in. Then select the motion analysis.

Create motors so that axes can be moved in the CAD model. These can be linked to NC axes or the PLC.
Set Servo Motor as the motor type. You can then choose whether displacement, acceleration or velocity
values are transferred.

The component to be moved or the axis to be moved must not be rigid in the model due to
constraints.

Proceed as follows to make the necessary settings:

ü The SOLIDWORKS® Motion Add-in is activated.
ü The component or the axis is movable.
1. In the Motion area, select Motion Analysis as the mode.
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2. Create the servomotors.

3. Select whether displacement, acceleration or velocity values are transferred.
4. Define sensors in the folder Sensors in the feature tree.

5. Right-click the Sensors folder to open the context menu.
6. Click the Add Sensors button.
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7. Select the sensor type Proximity under Sensor Type.

ð The first entry (blue) indicates the position of the sensor.
ð The second entry (pink) indicates the direction of the sensor.
ð The third entry (purple) indicates the components that are to interact with the sensor. Several entries

are possible here.
ð The distance from the sensor position at which the sensor is to be triggered is specified by the

length.
8. Click the green checkmark to activate the sensor.
9. Initialize the Simulation Runtime with the switch Init Runtime of the TwinCAT Add-in.

ð The Simulation Runtime is displayed as a SOLIDWORKS machine in the targets in the TwinCAT
project.
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10. If there are several motion studies in the CAD model, you can use the Select MotionStudy button to
select the motion study you want to simulate. 
By default, the first motion study displayed is selected.

11. Link the I/O master inputs to the relevant inputs in the PLC project. Link the individual I/O master outputs
with an output of an NC axis or a suitable output in the PLC project. See chapter I/O master set up in
TwinCAT [} 34].

12. Activate the TwinCAT project.
ð The query whether the TwinCAT system should be started in Run Mode appears.

13. Click OK.
14. Start the Runtime with the Start button in the toolbar of the TwinCAT Add-in.

ð Only when the simulation is started does the runtime begin to calculate.
15. Set a simulation duration.
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16. Start the simulation with the Calculate button.

ð The simulation is now started and the TwinCAT Runtime receives the ticks from the simulation
environment.

In the status bar the relation between simulation time and real time is displayed as information. The
TwinCAT Add-in does not affect the simulation speed in SOLIDWORKS®.

Further operation in TwinCAT and the implementation instructions for the simulation can be found in the
corresponding chapters of this documentation.
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6 I/O master set up in TwinCAT
In TwinCAT, the sensors and axes are linked and the motion simulation is controlled. Regardless of the CAD
tool used, the function for linking in TwinCAT is always the same.

Loading parameters and sensors in TwinCAT (TwinCAT 3.1.4026)
ü The runtime in the TwinCAT Add-in of the CAD tool was initialized.
ü The TwinCAT project is open.
ü The target in the TwinCAT project was set as either "SOLIDWORKS Machine" or "Inventor Machine".
1. Under System, select the TcCOM object.

2. Click scan .
ð All set axes and sensors from the CAD tool are loaded into TwinCAT and displayed as either inputs or

outputs. Information from the CAD tool is transferred to the PLC project via the inputs. Information from
the PLC project is transferred to the CAD project via the outputs.

ð If you load new axes of your CAD model into TwinCAT, all existing links are preserved. Only the new
axes and sensors are then added.

Loading parameters and sensors in TwinCAT (TwinCAT 3.1.4024)
ü The runtime in the TwinCAT Add-in of the CAD tool was initialized.
ü The TwinCAT project is open.
1. Under SYSTEM, right-click the TcCOM objects.
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2. Select Add New Item.

ð The window Insert TcCom Object opens.

3. Click Reload.
4. Select the appropriate element under the node Beckhoff Automation.
5. Confirm with OK.
ð All set axes and sensors from the CAD tool are loaded into TwinCAT and displayed as either inputs or

outputs. Information from the CAD tool is transferred to the PLC project via the inputs. Information from
the PLC project is transferred to the CAD project via the outputs.

Linking axes
ü The runtime in the TwinCAT Add-in of the CAD tool is initialized.
ü Axes and sensors are loaded in TwinCAT.
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1. First, create a new Motion configuration by right-clicking MOTION.

2. Select Add New Item.
ð The window Insert Motion Configuration opens.

3. Enter a name for the configuration.
4. Confirm with OK.
5. Create an axis by right-clicking Axes.
6. Select Add New Item.

ð The window Insert an NC axis opens.
7. Enter a name for the axis and confirm with OK.
8. Right-click on the axis of the TcCom object.
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9. Select Change Link....
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ð The Attach Variable window opens.

10. Select the axis in the MOTION area to which you want to link the axis from CAD.
11. If the desired axis is already linked with a project, uncheck the checkbox Only Unused to see all created

axes.
12. Confirm with OK.
13. To set the context, double-click the top node of the TcCom object.
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14. Select the Context tab.

15. Assign a task to the object using the drop-down menu Task. 

If you use NC axes, it is recommended to select "NC-Task 1 SAF".
16. Activate the configuration.
ð You can now run the simulation.

Conversion of axis positions between TwinCAT project and CAD project

You have the possibility to make settings regarding the axes and sensors in the TwinCAT I/O master. At Unit
you have the option of setting the desired unit for an axis, for example. The numerical value written into the I/
O master is converted according to the set unit and transferred to the CAD tool. In addition, the set offset as
well as the limits of the range monitoring from Inventor® are also interpreted according to the set unit.

1. Open the desired top node of an object.
2. Click the Parameter tab.
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3. Go to Value and set the units for Offset according to your requirements.

ð This results in a conversion depending on the selected unit.

Units

In Inventor, the units can be set according to the model hierarchy after scanning the configuration in the
TwinCAT project. One unit for translatory axes and one unit for rotatory axes can be set separately for each
assembly. In addition, a unit can be set for each axis according to its type (translatory/rotatory).

By default, the units "millimeter" and "degree" are set in the main assembly. "inheritFromParent" is set by
default for all subassemblies and all axes and displacement sensors. This means that all axes and
displacement sensors take over the units of the higher-level assembly in this case. If the units are changed
based on this default setting at the level of a subassembly, then the units of this subassembly apply to all
subordinate subassemblies, axes and displacement sensors. With the selection "inheritFromMainAssembly",
subordinate assemblies, axes or displacement sensors can take over the units of the main assembly.
Furthermore, it is possible to set a unit individually for each axis or displacement sensor.
The units of Inventor® and SOLIDWORKS® are irrelevant here. Different units can be set in the CAD model.

Offset and "InvertDirection"

The joint origin in the CAD tool and the axis origin assumed by the PLC may not be identical. We
recommend setting both the offset and the direction in the TwinCAT project after loading or scanning the
axes and sensors.

1. First adjust the direction.
ð If PLC and CAD coordinate system point in the same direction, then "InvertDirection" is set to

"FALSE", otherwise "InvertDirection" is set to "TRUE".
2. Set the offset between the two coordinate systems in the respective axis or displacement sensor unit.
ð The joint origin is now converted.

Example

In this example, the vertical motion axis of a miller is parameterized. 
The CAD coordinate system points in the opposite direction and has an offset with respect to the PLC
coordinate system. The offset is 150 mm. According to the scheme explained above, the unit "cm" was set
for the axis. So for this example you have to set "InvertDirection" to "TRUE" and the "Offset" to "15".
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The range monitoring of the axis is defined in the PLC coordinate system and in the axis units. In this
example, the range monitoring is to trigger when the axis exceeds the defined range of 5 or - 5. Therefore
parameterize "-5" for "Min" and "5" for "Max".

The conversion between axis position in PLC coordinates xAxis,PLC and CAD coordinates xAxis,CAD is described
below:

• Factor for direction inversion:

{ }1 1dirs Î -
If "InvertDirection" is "TRUE", then sdir = -1 otherwise sdir = 1.

• Offset in the specified unit:

dÎR
• The conversion factor sunit of the selected unit (translational: micrometer, millimeter, centimeter, meter,

inch, foot or rotational: degree, radian)
• Lower limit of range monitoring in the specified unit xmin.
• Upper limit of range monitoring in the specified unit xmax.
• Conversion of axes from the PLC to the CAD tool (identical for SOLIDWORKS and Inventor):

( ). ,Axis CAD dir Axis PLC Unitx s x d s= × + ×
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• Condition for range monitoring of axes (only for Inventor):

( ),
1

mindir Axis CAD Units x s d x-× × - £

( ),
1

maxdir Axis CAD Units x s d x-× × - ³

• Conversion of collision sensors, from CAD tool to PLC (only for Inventor):

( ). , . ,
1

Displ Sensor PLC dir Displ Sensor CAD Unitx s x s d-= × × -

• Conditions for range monitoring for the collision sensors, from the CAD tool to the PLC (only for
Inventor):

( ). , min
1

dir Displ Sensor CAD Units x s d x-× × - £

( ). , max
1

dir Displ Sensor CAD Units x s d x-× × - ³



Execution of the simulation

TE1130 43Version: 1.0.1

7 Execution of the simulation
Since the execution of the simulation does not differ much between the different CAD programs, the
following chapter explains it using Autodesk® Inventor® as an example.

When executing the simulation, it is possible to move individual axes or start a PLC project. The following is
an example of how you can move individual axes.

ü The CAD model is open.
ü The TwinCAT project is open.
ü A PLC project is open.
ü The TwinCAT Runtime is initialized.
1. Start the TwinCAT Runtime in the add-in of the CAD tool or activate the configuration in the TwinCAT

project.
2. Open the axis that will be moved by double-clicking on it.
3. Select the Online tab.

4. To move manually, first set the controller enable.
5. Move the axis using the buttons +, ++ or the keys [F3], [F4] and the buttons -, -- or the keys [F1], [F2].

https://infosys.beckhoff.com/content/1033/tf50x0_tc3_nc_ptp/2834766219.html
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ð The movement of the axis is now visible in the CAD model.

6. Stop the simulation by stopping the TwinCAT Runtime in the CAD tool add-in.
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8 Support and Service
Beckhoff and their partners around the world offer comprehensive support and service, making available fast
and competent assistance with all questions related to Beckhoff products and system solutions.

Download finder

Our download finder contains all the files that we offer you for downloading. You will find application reports,
technical documentation, technical drawings, configuration files and much more.

The downloads are available in various formats.

Beckhoff's branch offices and representatives

Please contact your Beckhoff branch office or representative for local support and service on Beckhoff
products!

The addresses of Beckhoff's branch offices and representatives round the world can be found on our internet
page: www.beckhoff.com

You will also find further documentation for Beckhoff components there.

Beckhoff Support

Support offers you comprehensive technical assistance, helping you not only with the application of
individual Beckhoff products, but also with other, wide-ranging services:

• support
• design, programming and commissioning of complex automation systems
• and extensive training program for Beckhoff system components

Hotline: +49 5246 963-157
e-mail: support@beckhoff.com

Beckhoff Service

The Beckhoff Service Center supports you in all matters of after-sales service:

• on-site service
• repair service
• spare parts service
• hotline service

Hotline: +49 5246 963-460
e-mail: service@beckhoff.com

Beckhoff Headquarters

Beckhoff Automation GmbH & Co. KG

Huelshorstweg 20
33415 Verl
Germany

Phone: +49 5246 963-0
e-mail: info@beckhoff.com
web: www.beckhoff.com

https://www.beckhoff.com/en-gb/support/download-finder/index-2.html
https://www.beckhoff.com/support
https://www.beckhoff.com/
https://www.beckhoff.com/
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